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11.2.

Minimization tasks



INTRODUCTION
This manual is developed by Andrejs Kostromins, author of the ConvAn. In case of any

problems feel free to contact author by e-mail: andrejs.kostromins@gmail.com.

ConvAn v1.0 graphic user interface (GUI) consists of 6 separate parts divided by their

functionality. All parts are accessible from the main menu strip in main window of ConvAn. Each of
menu items has name with intuitively understandable functionality.

In this manual author will show all the possibilities and functionality of ConvAn v1.0 in user
friendly way with color pictures. Sample date for exercising can be downloaded from

http://www.sysbio.lv/convan/sample files.



mailto:andrejs.kostromins@gmail.com
http://www.sysbio.lv/convan/sample_files

1. MAIN WINDOW

The main window of ConvAn v1.0 consists of 3 parts: main menu strip, loaded data column
viewer, and loaded data graphical viewer (see Figure 1).
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Figure 1. Structure of the main window of ConvAn v1.0.

1.1.  Main menu strip
Main menu strip consists of 6 menu items:
e File;
e Data;
e Profile;
e Method;
e Optimizations;

e Analyze.



Each of them has several lower level menu items which lead to new windows for particular
tasks.
1.1.1. Main menu item File
The main menu item File consists of 2 lower level menu items (see Figure 2):
e Open text file... (load data into ConvAn);
e Exit (exit the ConvAn).

a5’ ConvAn v10
| File | Data Profile Method

Open text file...
Exit

Figure 2. Lower level menu items of main menu item File in ConvAn v1.0.

1.1.2. Main menu item Data

The main menu item Data consists of 5 lower level menu items (see Figure 3):
e Associate to X axis (associate data from chosen column to X axis);
e Associate to Y axis (associate data from chosen column to Y axis);
e Add to graph (show associated data on the loaded data graphical viewer);
e Sava to database (save associated data to database);

e Clear all (clear all loaded data).
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Figure 3. Lower level menu items of main menu item Data in ConvAn v1.0.

1.1.3. Main menu item Profile
The main menu item Profile consists of 2 lower level menu items (see Figure 4):
e New... (create new profile);

e Edit... (edit existing profile).
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Figure 4. Lower level menu items of main menu item Profile in ConvAn v1.0.

1.1.4. Main menu item Method
The main menu item Method consists of 2 lower level menu items (see Figure 5):
e New... (create new method);

e Edit... (edit existing method).
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Figure 5. Lower level menu items of main menu item Method in ConvAn v1.0.

1.1.5. Main menu item Optimizations
The main menu item Optimizations consists of 2 lower level menu items (see Figure 6):
e View (view optimization data grouped in profile);

e Edit (edit saved optimization data).
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Figure 6. Lower level menu items of main menu item Optimizations in ConvAn v1.0.

1.1.6. Main menu item Analyze
The main menu item Analyze consists of 2 lower level menu items (see Figure 7):
e Maximization analyzer (analyze maximization tasks);

e Minimization analyzer (analyze minimization tasks).
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Figure 7. Lower level menu items of main menu item Analyze in ConvAn v1.0.



1.2. Loaded data column viewer
In the loaded data column viewer are shown all the columns user had loaded before. From
these columns user can choose what data series associate to X and Y axes (see Figure 8).
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Figure 8. Sample data loaded into data column viewer in ConvAn v1.0.



1.3. Loaded data graphical viewer

When loaded date columns are associated to X and Y axis, user can draw results on the plot.
Plot functions in ConvAn v1.0 performs loaded data graphical viewer. The names of columns are
associated to corresponding plot axes and plot title is generating according to chosen columns as
well (see Figure 9).
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Figure 9. Sample data loaded into data graphical viewer in ConvAn v1.0.



2. LOAD DATA INTO CONVAN V1.0

ConvAn v1.0 operates with .txt extension files, where optimization results are stored as time

series in columns separated by TAB separator (see Figure 10).

# - (Timer ) CEU -TimeWValues [&] -+ Values [B] -+ Values [ER]=+1
0.234001 —» 0.%86743 - 4.021%8 —» 1.77114 - 9
445,388 -+ 0.%g043 -+ 4.02767 -+ 1.771%c -+ 9
982,188 —-+ 0.%65208 - 4.0498 —- 1.77517 =+ 9
16896.21 —-» ©0.%645844 - 4.05637 =+ 1.776l2 -+ 9
3851.22 —+ 0.%g6482% -+ 4.0%c6d4 -+ 1.77ele -+ 9
3913.82 —- 0.%g4748 - 4.05813 —» 1.776327 -+ 9
4195.97 -+ 0.%84736 -+ 4.05831 -+ 1.7764 =+ 9
4591.458 —-» 0.%84708% - 4.0588 —- 1.77647 - 9
4974.93 - 0.%g4703 - 4.058%1 -+ 1.77e4% -+ 9
5150.25 -+ 0.%g47 -+ 4.058%8 -+ 1.7764% -+ 9
5387.5 =+ 0.%g465%8 - 4.058%8 —» 1.7765 =+ 9
598G.58 —» 0.%g846597 —» 4.05%01 —-» 1.7762 =+ 9
6287.88 —-» 0.%646%7 —-» 4.059012 —» 1.77e5 -+ 9
6804.72 —-» 0.%64687 —-» 4.0591% —» 1.77653 -+ 9
7186.42 -+ 0.%g4685 -+ 4.05%23 -+ 1.77653 =+ 9
10947.7 —-» 0.%64885 —» 4.05%24 —» 1.77653 -+ 9
11604.3 —-» ©0.%64885 —» 4.059%24 —» 1.77653 -+ 9
11800.1 —-+ ©O.%gd4885 -+ 4.05%24 —+ 1.77e53 -+ 9
12685.9 —-» 0.%64685 —» 4.059%24 —» 1.77653 —-» 9
14214+0.%64685 -+ 4.05%24 —- 1.77653 - 1
172%4.7 —-» ©0.%64685 —» 4.05%24 —» 1.77653 -+ 9
18364.1 —-+ O.%gd4g885 -+ 4.05%24 —+ 1.77e53 -+ 9
257683.5 —-» 0.%g84685 - 4.05%24 —» 1.77653 -+ 9
27510.1 - 0.%84685 - 4.05%24 —» 1.77653 -+ 9

Figure 10. Text file example with 4 data columns, where arrows represent TAB separators.

Text files can be loaded by selecting following menu items: File > Open text file... (see

Figure 2). In the next step user must choose text file in the window “Open” (see Figure 11).
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Figure 11. The window “Open” for browsing for text file in ConvAn v1.0.

When data file is chosen, click the button “Open” and the window for column selection will
appear (see Figure 12), where user can tick mark on necessary data column by double click on

corresponding column title.
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Figure 12. The window “Choose column” in ConvAn v1.0.

After actual column selection click the button “Next...” in order to load selected data into

ConvAn v1.0. Data will appear in loaded data column viewer (see Figure 8).



3. SAVE LOADED DATE IN DATABASE

The data represented in loaded data viewer (see Figure 8) can be stored in database. Firstly, it
is necessary to associate one column for each graph axis by clicking on column header and then
executing Data —> Associate to X axis or Data > Associate to Y axis (see Figure 3).

Secondly, user must check if associations were done correctly by drawing data on plot by
executing Data -> Add to graph. That leads to pictorial representation of associated columns in
loaded data graphical viewer (see Figure 9).

Thirdly, it is necessary to connect chosen optimization data to particular profile. By execute
Data —-> Save to database (see Figure 3) ConvAn v1.0 will open the new window — “Save
optimization data” (see Figure 13), where user has to give the name to optimization and choose

profile from already registered or have to create new one.
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Figure 13. The window “Save optimization data” in ConvAn v1.0.

Registered profiles are accessible from drop down menu “Profile name”. When particular

profile is chosen, the profile information is shown in the other fields in the window (see Figure 14).
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Figure 14. The window “Save optimization data” with filled fields in ConvAn v1.0.

If there is no appropriate profile to choose, user can create the new one by clicking on the

button “Add profile” (how to create new profile is described in the chapter 4 “CREATE NEW
PROFILE”). After these steps user has to click the button “Save” and ConvAn v1.0 will notify if
operation was success (see Figure 15).

Information

5

Figure 15. The window “Information” about successfully stored optimization data in ConvAn v1.0.



4, CREATE NEW PROFILE
There are two ways how to open the window for profile creation:
e Dby executing Profile = New... (see Figure 4),
e from the window “Save optimization data” (see Figure 13).

In both cases the window “New Profile” will appear (see Figure 16).
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Figure 16. The window “New Profile” in ConvAn v1.0.

From the “Choose already registered profile as a template” drop down menu user can choose
the most appropriate already registered profile as template for the new one. When particular profile
is selected, the other fields are automatically filled with information about chosen profile (see
Figure 17).
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Figure 17. The window “New Profile” with chosen profile as a template in ConvAn v1.0.

The name of profile must be unique. Whether profile is being made from template or not, it is
possible to freely write date in the fields for user needs. The drop down menu “Optimization
method” holds in all the previously declared optimization methods. If in the list there is no
appropriate optimization method, user can declare the new one by clicking on the button “Add
method” (how to declare new method is described in the chapter 6 “DECLARE NEW METHOD).

When all required fields are filled with data user can create the profile by clicking on the

button “Create profile” and ConvAn v1.0 will notify if operation was success (see Figure 18).

Information
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| 22|

Figure 18. The window “Information” about successfully stored profile in ConvAn v1.0.




5. EDIT/DELETE EXISTING PROFILE
Profile editing contains profile update operation and profile deletion operation. In both cases
first of all user has to choose which profile to modify from “Profile name” drop down menu (see
Figure 19)
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Figure 19. The window “Edit/Delete profile ” for profiles modification in ConvAn v1.0.

When particular profile is selected, the other fields are automatically filled with information
about chosen profile (see Figure 20).
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Figure 20. The window “Edit/Delete profile” with chosen profile in ConvAn v1.0.

Deletion operation can be performed by clicking on the button “Delete”. After successful

deletion the window “Information” will appear (see Figure 21). As a result not only particular

profile will be deleted but all connected optimization data will be deleted too.

Information

:I Profile was deleted successfully!

| 22|

Figure 21. The window “Information” about successfully deleted profile in ConvAn v1.0.

If user is not interested in profile deletion but just wants to modify some profile parameters,

user can make changes in the fields and save changes by clicking on the button “Update”. After

successful update operation the window “Information” will appear (see Figure 22).
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Figure 22. The window “Information” about successfully updated profile in ConvAn v1.0.

The drop down menu “Optimization method” holds in all the previously declared optimization
methods. If in the list there is no appropriate optimization method, user can declare the new one by
clicking on the button “Add method” (how to declare new method is described in the chapter 6
“DECLARE NEW METHOD”).



6. DECLARE NEW METHOD
There are three ways how to open the window for method declaration:
e by executing Method - New... (see Figure 5),
e from the window “New Profile” (see Figure 16),
e from the window “Edit/Delete profile” (see Figure 19).
In all cases the window “New Method ” will appear (see Figure 23).

ot Mew method [= = | == |

Mame

Method description (optional)

Figure 23. The window “New Method” in ConvAn v1.0.

The name of method must be unique meanwhile “Method description” field is optional and
can be left empty. When data is filled in, user can declare the method by clicking on the button

“Add” and ConvAn v1.0 will notify if operation was success (see Figure 24).

Information [ == |

:I Method was stored in data base successfully!

Figure 24. The window “Information” about successfully stored method in ConvAn v1.0.




1. EDIT/DELETE EXISTING METHOD
Method editing contains method update operation and method deletion operation. In both
cases first of all user has to choose which method to modify from “Choose method” drop down

menu (see Figure 25)

85 Edit/Delete method o || = | ==
Choose method - Mew name
Method description {optional) Mew description {optional)

Figure 25. The window “Edit/Delete method” for methods modification in ConvAn v1.0.

When particular method is selected, the other fields are automatically filled with information

about chosen method (see Figure 26).
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Figure 26. The window “Edit/Delete method” with chosen method in ConvAn v1.0.

Deletion operation can be performed by clicking on the button “Delete”. After successful
deletion the window “Information” will appear (see Figure 27). As a result not only particular

method will be deleted but all connected profiles and optimization data will be deleted as well.
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Information

:I Method was deleted successfully!

Figure 27. The window “Information” about successfully deleted profile in ConvAn v1.0.

If user is not interested in method deletion but just wants to modify methods parameters, user
can make changes in the fields and save changes by clicking on the button “Update”. After

successful update operation the window “Information” will appear (see Figure 28).

Information [ == |
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Figure 28. The window “Information” about successfully updated method in ConvAn v1.0.




8. ANALYZE PROFILE OPTIMIZATION DATA
In ConvAn v1.0 it is possible to analyze every profile as a data set in order to see tendencies
and stability of particular optimization run depending on optimization parameters. The window

“Profile analyzer” (see Figure 29) can be accessed by executing Optimizations -> View (see

Figure 6).
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Figure 29. The window “Profile analyzer” for profile analysis in ConvAn v1.0.

First of all user has to set analysis settings. In the window “Profile analyzer” there are three
checkboxes (“Show all series”, "Show error bar”, "Logarithmic scale”), slide bar (“Density of
error bars”) and input field for discretization step (“Discretization step (sec)”). By default all
checkboxes are marked, slide bar is set to left side (max density of error bars), and discretization
step is set to 50 seconds. The functionality of “Show all series” checkbox will be discussed later.
“Show error bar” checkbox enables or disables visualization of error bars for average curve of all
optimization runs for chosen profile. ”Logarithmic scale” checkbox switches X axis between linear
or logarithmic scales. “Density of error bars” slide bar regulates how often error bars are visualized
on the average curve. Discretization step is very important parameter, because profile analysis and
all calculation steps depend on value of discretization. Discretization step in seconds indicates how
often ConvAn v1.0 performs better value check in all data series of optimization runs and calculates

average values after each iteration which is equal to set discretization step. If discretization step is



chosen too big, analysis will not be correct and graphical representation may be artificially

prolonged at X axis but very small discretization step will lead to time consuming analysis in case of

long optimization runs. The best way how to choose appropriate discretization step is to look at data

series of optimization runs and find out the smallest time between two optimization values.

When analysis settings are set, user can choose the profile from “Choose profile” drop down

menu. ConvAn v1.0 will prompt for confirmation of discretization step (see Figure 31).

Question

[9] Time step is set to 50, Would you like to continue?

£3

Yes | | Mo

Figure 31. The window “Question” for confirmation of discretization step in ConvAn v1.0.

If user clicks on the button “No”, it is possible to change settings, but in case of approval (the

button “Yes”) ConvAn v1.0 returns a list of optimizations which are connected to that profile and

graphical representation on the plot (see Figure 32).
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Figure 32. The window “Profile analyzer” for profile analysis with chosen profile in ConvAn v1.0.



Graph can be zoomed in and zoomed out, it can be saved as picture for further analysis. These
options are accessible from the context menu dialog box, when the right button of mouse is clicked
on the plot (see Figure 33).

Copy

SaveImage As...

Page Setup...

- — Print... -+

1[}[] 1[}1 1[}2 Show Point Values 1[}5 1[}5

Un-Zoom
CPU_Ti

Undo All foom/Pan

Set Scale to Default

Figure 33. Context menu dialog box for plot functions in ConvAn v1.0.

All series on the plot are shown in black color by default but user can choose which series to
show and can change the color for each series as well. In order to choose which series to show user
has to click on series name in the list of series under “Choose profile” drop down menu. In order to
hide series user has to do the same operations as mentioned above.

When series is selected it appears on the plot and it’s name in the selected series list. Then
user can change color by clicking on series in selected series list (left bottom corner) and choosing

the color from “Choosing series color” drop down menu (see Figure 34).
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Figure 34. The window “Profile analyzer” for profile analysis with chosen profile and some series

in ConvAn v1.0.

If it is necessary to reanalyze profile with different discretization step, it is possible to change
discretization step in the field and click on the button “Redraw”.




Q. EDIT/DELETE OPTIMIZATION DATA

In ConvAn v1.0 it is possible to look at every optimization run one by one as data series
columns and graphical representation. These functions are available in the window “View
optimization” (see Figure 35). It can be accessed by executing Optimizations - Edit (see Figure
6).
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Figure 35. The window “View optimization ” for optimizations data modification in ConvAn v1.0.

From “Choose optimization” drop down menu user can choose optimization run and
corresponding data series appears in the left side of the window and graphical representation appears

on the plot (see Figure 36).
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Figure 36. The window “View optimization” with selected optimization run in ConvAn v1.0.



User can change the name of optimization run in “New name” input field and save it by
clicking on the button “Update” or delete chosen optimization run by clicking on the “Delete”
button. For both actions in case of success ConvAn v1.0 shows windows “Information” (see Figure
37 and Figure 38).

g

Information

:I Optimization was updated successfully!

Figure 37. The window “Information” about successfully updated optimization in ConvAn v1.0.

Information [ =3 |

I Optimization data was deleted from data base successfully!

Figure 38. The window “Information” about successfully deleted optimization in ConvAn v1.0.




10. COMPARING OPTIMIZATION METHODS DEPENDING ON
DIFFERENT ADJUSTABLE PARAMETER SETS

10.1. Maximization tasks

Maximization tasks for ConvAn v1.0 mean that the highest value of objective function is
sought during optimization run. ConvAn v1.0 is able to perform statistical calculations to help user
to compare optimization methods each other. This feature is available in the window “Maximization

analyzer” (see Figure 39) by executing Analyze - Maximization Analyzer (see Figure 7).
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Figure 39. The box “Compare two methods” in the window “Maximization analyzer” in ConvAn
v1.0.

This is one of the biggest window in ConvAn v1.0 that contains not only optimization
methods comparison functions but particular optimization method behavior analysis and prediction
functions as well (how to use optimization method behavior analysis and prediction functions is
described in the chapter 11 “ANALYZE AND PREDICT BEHAVIOUR OF PARTICULAR METHOD
DEPENDING ON DIFFERENT ADJUSTABLE PARAMETER SETS”). How to use “Density of
error bars” slide bar and “Discretization step (sec)” input field is previously described in the
chapter 8 “ANALYZE PROFILE OPTIMIZATION DATA”. After parameter tuning user has to



choose values for input fields from drop down menus. “Number of metabolites” drop down menu
indicates on number of metabolites in the model. “Number of reactions” drop down menu indicates
on number of reactions in the model. “Number of parameters” drop down menu indicates on
number of parameters of reactions in the model. “Number of adjustable parameters” drop down
menu indicates number of those reactions parameters that were modified during the optimization
process. “Optimization method 1~ and “Optimization method 2"’ drop down menus indicate on two
methods which user wants to compare depending on previously described configuration (drop down
menus). “X axis title” and “Y axis title” drop down menus indicate on titles of axes which were
given during profile creation. Finally user can compare methods by clicking on the button
“Compare methods”. ConvAn v1.0 then shows information about the best values of interested
methods in the result boxes (see Figure 40).
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Figure 40. The result boxes in the window “Maximization analyzer” in ConvAn v1.0.

Another thing that ConvAn v1.0 returns is the best result over all methods in one box (see
Figure 41) and finds out initial and the best value of optimization runs for interested methods in the
other two boxes (see Figure 42). In the “Best result over all methods” box is shown not only the

best value but those methods where this value was obtained during optimization runs depending on



methods’ comparing parameters that were set before in the

ConvAn v1.0.
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Figure 41. The box “Best result over all methods” in the window “Maximization analyzer” in
ConvAn v1.0.
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Figure 42. Initial value and the best value boxes in the window “Maximization analyzer” in
ConvAn v1.0.

Initial value and the best value are the key numbers for percentage normalization on the graph.
ConvAn v1.0 offers automatically obtained numbers from data sets of optimization runs that are
stored in the data base but it is possible to change these values manually by selecting the radio
button “Use custom value” and filling in appropriate numbers in the input field (see Figure 42).
Initial value corresponds to starting point of normalization — 0% but the best value corresponds to
ending point of normalization - 100%. By setting these values manually user can change potential
minimum and maximum that would be necessary if user knows according to other sources that these
values could be different from those that were obtained automatically from data series of
optimization runs.

Manually curated values will take effect after clicking on the button “Redraw” as a result

graphical representation changes according to new values.



10.2. Minimization tasks

Minimization tasks for ConvAn v1.0 mean parameter estimation when the smallest distance

between experimental data and optimization data is sought during optimization runs. ConvAn v1.0

is able to compare optimization methods in minimization tasks as well. This feature is available in

the window “Minimization analyzer” (see Figure 43) by executing Analyze - Minimization

Analyzer (see Figure 7).
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Figure 43. The box “Compare two methods” in the window “Minimization analyzer” in ConvAn

v1.0.

This window looks identical to the window “Maximization analyzer” (how to use

optimization method behavior analysis and prediction functions is described in the chapter 11
“ANALYZE AND PREDICT BEHAVIOUR OF PARTICULAR METHOD DEPENDING ON
DIFFERENT ADJUSTABLE PARAMETER SETS”). How to use “Density of error bars” slide bar
and “Discretization step (sec)” input field is previously described in the chapter 8 “ANALYZE
PROFILE OPTIMIZATION DATA” and usage of other input fields and drop down menus is
previously described in the chapter 10.1 “Maximization tasks”.



It is important to remember that in the window “Minimization analyzer” initial value is bigger
than the best value because during optimization runs distance between experimental data and model
data is decreasing.



11. ANALYZE AND PREDICT BEHAVIOUR OF PARTICULAR METHOD
DEPENDING ON DIFFERENT ADJUSTABLE PARAMETER SETS

11.1. Maximization tasks

ConvAn v1.0 offers opportunity to analyze one particular method deeper that can help to

predict method behavior with different adjustable parameter sets. This is the other feature that is

H H H “« .. . i) H H
available in the window “Maximization analyzer” (see Figure 44) by executing Analyze ->
Maximization Analyzer (see Figure 7).
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Figure 44. The box “User data” in the window “Maximization analyzer” in ConvAn v1.0.

Before running this function user has to perform methods comparison in order to get initial
value and the best value (how to compare methods is described previously in the chapter 10.1
“Maximization tasks ) for percentage normalization on the graph. Another option is to fill in initial
value and the best value manually (how to fill in initial and the best value is described previously in
the chapter 10.1 “Maximization tasks”).

For analysis user has to provide ConvAn v1.0 with all necessary data in the box “User data”
(how to fill the drop down menu input fields is described in the chapter 10.1 “Maximization tasks”).

The next step is to start analysis by clicking on the button “Calculate”. ConvAn v1.0 tries to return



the nearest graph depending on the value in the drop down menu “Number of adjustable
parameters” input field, for example, if user has filled in value of 5 but in the data base there are no
records with such number of adjustable parameters, then ConvAn v1.0 for calculation uses next
smaller and next higher available number of adjustable parameters and returns two curves instead of

one (see Figure 45).
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Figure 45. Two curves of the closest adjustable parameter numbers in the window “Maximization

analyzer” in ConvAn v1.0.

In such cases it means that user’s curve should be somewhere between those two. User can
draw the other curves for method just by clicking on entries in the list box “Adjustable parameters”
and then by clicking on the button “Draw”, selected series appear in the near list box “Series” and
on the plot (how to use checkbox “Logarithmic scale”, checkbox “Show error bars”, and how to
change series colors is previously described in the chapter 8 “ANALYZE PROFILE OPTIMIZATION
DATA”).



11.2. Minimization tasks
In ConvAn v1.0 is possible to analyze behavior of method for minimization tasks as well. This
is the other feature that is available in the window “Minimization analyzer” (see Figure 46) by

executing Analyze > Minimization Analyzer (see Figure 7).
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M“User data” in the window “Minimization analyzer” in ConvAn v1.0.

How to perform method analysis is previously described in the chapter 11.1 “Maximization

tasks”.



